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wxDev-C++ is an extension of Dev-C++ by Colin Laplace et. al. This program
helps you to visually create dialogs and frames for wxWidgets. With all the
wonderful features of Dev-C++, wxDev-C++ is still being actively developed.
The main aim of this project is to provide the wxWidgets community with a free,
open-source, commercial-grade IDE/RAD tool for development with
wxWidgets.


http://wxdsgn.sourceforge.net/
http://bloodshed.net/dev/devcpp.html
http://wxwidgets.org/
http://en.wikipedia.org/wiki/Integrated_development_environment
http://en.wikipedia.org/wiki/Rapid_application_development

Features:
Plugin Capable:

e Modules can be added at runtime to expand the IDE's capabilities
e Users can chose between wxDev-C++ and the original Dev-C++ IDEs

wxWidgets Form Designer

Generates XRC XML resources

Drag-and-drop design paradigm

Supports wxWidgets' sizer-based layouts

Connect events to member functions within the editor

Integrated debugging

Support for GDB and CDB (WinDbg)
Variable watches

Automatic stack tracing

Local variables list

Displays disassembly and CPU registers

Editor features

Class browser

Code completion

Project management

Project profiles

Customisable syntax highlighting
Automatic inline assembly highlighting
ToDo List

Application compatibility

Built-in CVS support
e Supports MingW/Visual C++ (6, 2003 and 2005, 2008)



Quickly create Windows and console applications, static libraries and
DLL's

Support for project templates to expedite the creation of new project types

Package manager (through the use of DevPaks), for easy installation of add-
on libraries
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License Agreement

Dev-C++ and wxDev-C++ are distributed under the GNU General
Public License.

Be sure to read it before use.

GNU GENERAL PUBLIC LICENSE
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.,

51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your
freedom to share and change it. By contrast, the GNU General Public
License is intended to guarantee your freedom to share and change free
software--to make sure the software is free for all its users. This
General Public License applies to most of the Free Software
Foundation's software and to any other program whose authors commit to
using it. (Some other Free Software Foundation software is covered by
the GNU Lesser General Public License instead.) You can apply it to
your programs, too.

When we speak of free software, we are referring to freedom, not
price. Our General Public Licenses are designed to make sure that you
have the freedom to distribute copies of free software (and charge for
this service if you wish), that you receive source code or can get it
if you want it, that you can change the software or use pieces of it
in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid
anyone to deny you these rights or to ask you to surrender the rights.


http://www.gnu.org/licenses/old-licenses/gpl-2.0.html

These restrictions translate to certain responsibilities for you if you
distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether
gratis or for a fee, you must give the recipients all the rights that
you have. You must make sure that they, too, receive or can get the
source code. And you must show them these terms so they know their
rights.

We protect your rights with two steps: (1) copyright the software, and
(2) offer you this license which gives you legal permission to copy,
distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain
that everyone understands that there is no warranty for this free
software. If the software is modified by someone else and passed on, we
want its recipients to know that what they have is not the original, so
that any problems introduced by others will not reflect on the original
authors' reputations.

Finally, any free program is threatened constantly by software
patents. We wish to avoid the danger that redistributors of a free
program will individually obtain patent licenses, in effect making the
program proprietary. To prevent this, we have made it clear that any
patent must be licensed for everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and
modification follow.

GNU GENERAL PUBLIC LICENSE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND
MODIFICATION

0. This License applies to any program or other work which contains
a notice placed by the copyright holder saying it may be distributed
under the terms of this General Public License. The "Program", below,
refers to any such program or work, and a "work based on the Program"
means either the Program or any derivative work under copyright law:
that is to say, a work containing the Program or a portion of it,



either verbatim or with modifications and/or translated into another
language. (Hereinafter, translation is included without limitation in
the term "modification".) Each licensee is addressed as "you".

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running the Program is not restricted, and the output from the Program
is covered only if its contents constitute a work based on the

Program (independent of having been made by running the Program).
Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's
source code as you receive it, in any medium, provided that you
conspicuously and appropriately publish on each copy an appropriate
copyright notice and disclaimer of warranty; keep intact all the
notices that refer to this License and to the absence of any warranty;
and give any other recipients of the Program a copy of this License
along with the Program.

You may charge a fee for the physical act of transferring a copy, and
you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion
of it, thus forming a work based on the Program, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

a) You must cause the modified files to carry prominent notices
stating that you changed the files and the date of any change.

b) You must cause any work that you distribute or publish, that in
whole or in part contains or is derived from the Program or any
part thereof, to be licensed as a whole at no charge to all third
parties under the terms of this License.

c) If the modified program normally reads commands interactively
when run, you must cause it, when started running for such
interactive use in the most ordinary way, to print or display an
announcement including an appropriate copyright notice and a



notice that there is no warranty (or else, saying that you provide

a warranty) and that users may redistribute the program under

these conditions, and telling the user how to view a copy of this
License. (Exception: if the Program itself is interactive but

does not normally print such an announcement, your work based on
the Program is not required to print an announcement.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Program,

and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
distribute the same sections as part of a whole which is a work based

on the Program, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the

entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Program.

In addition, mere aggregation of another work not based on the Program
with the Program (or with a work based on the Program) on a volume of
a storage or distribution medium does not bring the other work under
the scope of this License.

3. You may copy and distribute the Program (or a work based on it,
under Section 2) in object code or executable form under the terms of
Sections 1 and 2 above provided that you also do one of the following:

a) Accompany it with the complete corresponding machine-readable
source code, which must be distributed under the terms of Sections
1 and 2 above on a medium customarily used for software interchange; or,

b) Accompany it with a written offer, valid for at least three
years, to give any third party, for a charge no more than your
cost of physically performing source distribution, a complete
machine-readable copy of the corresponding source code, to be



distributed under the terms of Sections 1 and 2 above on a medium
customarily used for software interchange; or,

c) Accompany it with the information you received as to the offer
to distribute corresponding source code. (This alternative is
allowed only for noncommercial distribution and only if you
received the program in object code or executable form with such
an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for
making modifications to it. For an executable work, complete source
code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to

control compilation and installation of the executable. However, as a
special exception, the source code distributed need not include
anything that is normally distributed (in either source or binary

form) with the major components (compiler, kernel, and so on) of the
operating system on which the executable runs, unless that component
itself accompanies the executable.

If distribution of executable or object code is made by offering
access to copy from a designated place, then offering equivalent
access to copy the source code from the same place counts as
distribution of the source code, even though third parties are not
compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program
except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense or distribute the Program is
void, and will automatically terminate your rights under this License.
However, parties who have received copies, or rights, from you under
this License will not have their licenses terminated so long as such
parties remain in full compliance.

5. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Program or its derivative works. These actions are
prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Program (or any work based on the



Program), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the
Program), the recipient automatically receives a license from the
original licensor to copy, distribute or modify the Program subject to
these terms and conditions. You may not impose any further
restrictions on the recipients' exercise of the rights granted herein.
You are not responsible for enforcing compliance by third parties to
this License.

7. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence you
may not distribute the Program at all. For example, if a patent
license would not permit royalty-free redistribution of the Program by
all those who receive copies directly or indirectly through you, then
the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended to
apply and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system, which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing

to distribute software through any other system and a licensee cannot



impose that choice.

This section is intended to make thoroughly clear what is believed to
be a consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Program under this License
may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates
the limitation as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions
of the General Public License from time to time. Such new versions will
be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.

Each version is given a distinguishing version number. If the Program
specifies a version number of this License which applies to it and "any

later version", you have the option of following the terms and conditions
either of that version or of any later version published by the Free

Software Foundation. If the Program does not specify a version number of
this License, you may choose any version ever published by the Free Software
Foundation.

10. If you wish to incorporate parts of the Program into other free
programs whose distribution conditions are different, write to the author
to ask for permission. For software which is copyrighted by the Free
Software Foundation, write to the Free Software Foundation; we sometimes
make exceptions for this. Our decision will be guided by the two goals
of preserving the free status of all derivatives of our free software and
of promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE
IS NO WARRANTY
FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE



LAW. EXCEPT WHEN

OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS
AND/OR OTHER PARTIES

PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED

OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
THE ENTIRE RISK AS

TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH
YOU. SHOULD THE

PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL
NECESSARY SERVICING,

REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR
AGREED TO IN WRITING
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY
MODIFY AND/OR
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE
TO YOU FOR DAMAGES,
INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING
BUT NOT LIMITED
TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR
LOSSES SUSTAINED BY
YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO
OPERATE WITH ANY OTHER
PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN
ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest
possible use to the public, the best way to achieve this is to make it



free software which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program. It is safest
to attach them to the start of each source file to most effectively
convey the exclusion of warranty; and each file should have at least
the "copyright" line and a pointer to where the full notice is found.

<one line to give the program's name and a brief idea of what it does.>
Copyright (C) <year> <name of author>

This program is free software; you can redistribute it and/or modify

it under the terms of the GNU General Public License as published by
the Free Software Foundation; either version 2 of the License, or

(at your option) any later version.

This program is distributed in the hope that it will be useful,

but WITHOUT ANY WARRANTY; without even the implied warranty of

MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See
the

GNU General Public License for more details.

You should have received a copy of the GNU General Public License along
with this program,; if not, write to the Free Software Foundation, Inc.,
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this
when it starts in an interactive mode:

Gnomovision version 69, Copyright (C) year name of author

Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type
“show w'.

This is free software, and you are welcome to redistribute it

under certain conditions; type “show c' for details.

The hypothetical commands "show w' and “show c' should show the appropriate
parts of the General Public License. Of course, the commands you use may
be called something other than "'show w' and "show c'; they could even be



mouse-clicks or menu items--whatever suits your program.

You should also get your employer (if you work as a programmer) or your
school, if any, to sign a "copyright disclaimer” for the program, if
necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the program
"Gnomovision' (which makes passes at compilers) written by James Hacker.

<signature of Ty Coon>, 1 April 1989
Ty Coon, President of Vice

This General Public License does not permit incorporating your program into
proprietary programs. If your program is a subroutine library, you may
consider it more useful to permit linking proprietary applications with the
library. If this is what you want to do, use the GNU Lesser General

Public License instead of this License.
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Credits

For Dev-C++

Developers : Colin Laplace, Hongli Lai, Mike Berg, Yiannis Mandravellos

MingW compiler system : Mumit Khan, J.J. Var Der Heidjen, Colin Hendrix and
GNU developers

Update system and initial work on the help file : Kip Warner
New Look theme : Gerard Caulfield:
Gnome icons : Gnome designers

Blue theme : Thomas Thron


http://www.bloodshed.net/devcpp.html
http://www.mingw.org/

For wxDev-C++

Developers:  Guru Kathiresan, Malcolm Nealon, Esteban Aguilar,
Edward Toovey, Nuklear Zelph, Joel Low, and Tony Reina

Update of Help File: Tony Reina


http://www.bloodshed.net/devcpp.html
http://wxdsgn.sourceforge.net/?q=node/19
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Getting Started

When you launch Dev-C++ for the first time, you will see the following dialog :

wxDev-C++ First-Run Configuraticn

Fle Edit Search | Thisisthefirsttime you have launched
B B wxDev-C++, Here are some questions to help
: I dJHY configure wxDev-C++ to your liking.
Select your language:
g | - g
ER G |0$’ lﬂ} E Ly Chinese (TW) o

dummy.cpp | 8PP.C| Cru:uatiar] m
I - | | Czech (Eeitina) 2
ik £4 777" | | Danish

b Dutch (Mederlands)

0 0 -

Select your wxDev-C++ theme:

|New Look j Preview

[ Usze XP Theme

| 1oyoadsu) yoalang | 10p0adsu) dpadaig

(Sl T Ve I 6 C R I Ny Y R WL 8
oot
m f

e
[

e

P Next

]
[§]

You can select the language wxDev-C++ will use, as well as the icon theme.
To add a XP flavor to wxDev-C++, check the ‘Use XP Theme’ box.

If you installed wxDev-C++ with the included Mingw compiler system, then all
MingW compiler paths will be set to their correct values. If you have previously
installed versions of Cygwin, MSYS, or MingW, they might interfere with
wxDev-C++. Although they can be used, you'll have to set up the compiler paths
and settings manually in the Tools menu under Compiler Options.

If you also have the MS Visual Studio compiler installed, wxDev-C++ will
attempt to detect it and add the relevant paths as well.

Now you can then proceed to the Basic Steps.
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Creating a Project

What is a wxDev-C++ Project ?

Projects are the way you manage different source files and compiler/linker
options inside wxDev-C++. It's an ini file (usually ending in the .dev extension),
which specifies what source files should be included in your program and what
compiler/linker parameters/switches you want to use to build them.

When to use wxDev-C++ Projects ?

(Answer: [Almost] Always)

e You have more than one source file - Using Projects ensures that all of your
source files are linked to the executable after they are compiled.

¢ You need to create a DLL or static library, or want to use resource files in
your program - Projects allow you to specify the compiler and linker
options necessary

How can I create a wxDev-C++ Project ?

Go to the File menu and click on New, then Project. A dialog opens, containing
different Project types.



Mew project &J

| Baﬂc|

H b o B3 & P

Emnpty wxWidgets  wxWidgets Console  Static Library DLL
wxWidge.., Dialog Frame Application

Description:

Project options:
Marne: " C Project » C++ Project

Projectl [ Make Default Language

Here are the basic Dev-C++ project types :

e Console application : creates a console (command-line shell) program

¢ Static library : creates an empty project with the options needed for
building a static library

e DLL : creates a Win32 Dynamic Link Library

In addition, wxDev-C++ contains three wxWidgets (GUI) project types:

e Empty wxWidgets project - A project that initially contains no source files
but has the correct compiler and linker settings to build wxWidgets source
code.

e wxWidgets Dialog - A project that contains skeleton source files for a
wxDialog

e wxWidgets Frame - A project that contains skeleton source files for a
wxFrame

Now that you selected your project type, fill the name of your project in the
corresponding edit box, select the programming language you will be using (C
or C++), and click on OK.
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Adding and Removing files

Adding and removing files is very easy.

You can add multiple files in the same time by clicking on Project menu, then on
Add to Project.

Project | Execute Debug T

_1 Mew file |

P asatoproect |

(& Remove from Project

B Project Options ~ Alt+P

You have different ways for removing files from your project.

Either click on Project menu, then on Remove from Project and select the file
you want to remove in the list, or right-click on the file you want to remove in
the Project Manager window, and click on Remove file
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Project options overview

You can load the Project Options dialog by clicking on the Project menu, then on
Options (shortcut :Alt+P).

General sheet :

ﬁ Project Options I&
Project Profile: | MingW 34.2 - | (2] (] () ()
General |Fi|es | Cormpiler | Parameters | Directories | Build Options | Makefile | Versicn info|
Mame: Projectl
Filename: ChUsersitony\Documents\Programmingjunk\Projectl.dev
Output file:  ChlsershtonyDocurnents\Programmingtjunk\ Output\MingWhProjectl .exe
Files: o files [2 sources, 2 headers, 1 resources)
Icon: Type:
IETTE R \Vindovs GUI Application 7
Windows Conscle Application (H
[ EL Browse ] Windows Static Library B
Windows Dvnamic Library R
& Remove [] Support Windows XP Themes
| o Ok { [ X Cancel ] [ ? Help ]

The first thing you may notice is that wxDev-C++ allows for multiple
compiler profiles for the same project. In the Project Profile section there is a
drop-down box with the available compiler profiles for the current project. Users
can switch the compiler profile between different compilers (e.g. MingW gcc
and VS 2008) or between different settings of the same compiler (e.g. debug
versus release profiles). You may add, remove, rename, or copy the profiles for
the current project by clicking on the icons to the right of the drop-down box.

4[] (@ (Note that these actions only affect the current project.)

Other items of this window:



Name: Modify here the name of your project.

Icon : You can assign an icon to your program, either by selecting one in the

Icon Library, or by giving your own icon using the Browse button.

Type : This is an important settings which indicates which project type you are

making. Select :

e Win32 GUI : if your application is a graphical user interface

e Win32 Console : if your application needs a console window (MS-DOS or
command shell window)

e Win32 Static Lib : if you are creating a static library
e Win32 DLL : if you are creating a dynamic link library (DLL)

Files sheet :

E Project Options

Sx2)

Project Profile: | MingW 34.2

| Hx @&

General | Files | Cormpiler | Parameters | Directories | Build Options | Makefile | Versicn info|

S-gi Projectl File options: _ =
----- (4 Projectl App.cpp = (=]
..... [3 ProjectlApp.h Include in compilation
..... [3 Projectl App.re Include in linking
..... [3 Projectl Frm.cpp Compile file as C++
..... [3 ProjectlFrm.h Chwerride build command
----- [ Projectl Frm.wadorm -

1 I
Precompiled Headers
i@ Mo precompiled header
Create precompiled header
Use precompiled header
| o Ok ] [ X Cancel ] [ ? Help ]

Regardless of the compiler used, wxDev-C++ uses the MingW make build




system to compile and link projects. Makefiles are automatically generated
based on the source files contained in the project. This window enables you to
modify the compilation commands and options for each source file to customize
the makefile that is generated.

Build priority : Increment this value in order to have the source file compiled in
priority of the others

Include in compilation : If not set, your file will not be compiled.

Include in linking : Add the object file generated from the source file to the
linking stage

Compile file as C++ : Check this flag if it is a C++ source file
Override build command : For experimented users only. You can change there

the command used by Dev-C++ to compile your file

Compiler sheet :

ﬁ Project Options (X
Project Profile: | MingW/ 34.2 -
| General | Files | Compiler | Pararneters | Directories | Build Options | Makefile | Versicn info|

MOTE: These settings will override the global Compiler Options affecting this project only.

Compiler: [Default GCC compiler ']
- C compiler: Support all ANSI standard C programs Mo j
C++ compiler: Atternpt to support some aspects of traditional C preprodMo
é----Cu:u:Ie Generation Inhibit all warning messages Mo
E----Cu:ude profiling Displays one error per line Mo
. Linker:

-- Optimization

| \/Qk |[ xgancel] [ ?ﬂelp]




See the Compiler Options section for more details.

Parameters sheet :

H Project Options (X
Project Profile: | MingW/ 34.2 - | () () () ()
| General | Files | Compiler | Parameters | Directories | Build Options | Makefile | Versicn info|
Cormpiler: C++ compiler: Linker:
-fno-exceptions # | | -fno-exceptions - -mwindows -
-fno-pec-struct-return || | -fno-pece-struct-return || | -lwsemswi28 i
-fstrict-aliasing _ || | ~fstrict-aliasing A -wernsw2E_gl
-Wall = | -wall 3 - bwetiff £
-D_WXMSW_ -D_WXMSW_ -lwxjpeg I
-D_GMNUWIN32__ | | -D_GNUWIN32__ — | | -lwxpng g |
-D__WINAS_ = | | -D_WIN95__ = | | -lwezlib |
1 } 1 } -Iwregex
-Iwexpat
Preprocessor Definitions: -lkernel32
_WHXMSW__ - -luzera
_GNUWIN32_ -lgdis2 -
_WINI5__ a1 ;
. ) | L Add Library or Object |
[ Ok ] [ X Cancel ] [ ? Help ]

You can provide here command line arguments to the C/C++ compilers and
linker.

Use the linker parameters box to specify libraries to link with your project.
For more information, please read the linker library section.

Directories sheet :



E Project Options ,__HJ u
Project Profile: | MingW/ 34.2 + | (4] (@)

| General | Files | Cormpiler | Parameters| Directories | Build Opticns | Makefile | Version infu|

I LI el Include Directories | Resource Directories |

| 4

Replace || Add || Delete | |Deletelnvalid| |

o] (Xona] [ 2]

You can provide here a list of Includes, Resources and Libraries directories to be
searched when compiling/linking. These directories are only used for the current
project and profile.

Build Options sheet :



ﬁ Project Options ﬁ1
Project Profile: | MingW/ 34.2 + | (4[] [ (&)

| General | Files | Cormpiler | Parameters | Directories | Build Options |Makeﬁ|e | Versicn info|

Directories
Executable output directory

DutputyMingW
Object file cutput directory

Objects\MingW r

[C] Override output filename "

Projectl exe

[ W Ok ][xgancel] [ '?Help]

Han

Executable output directory : Specify here the directory where your executable
will be created (default is project’s directory).

Object file output directory : Specify here the directory where your object files
will be created (default is source file’s directory).

Override output filename : You may change the output filename of your program
here.

Makefile sheet :



H Project Options Iﬁ"
Project Profile: | MingW/ 34.2 v () (3¢ (@) &)

| General | Files | Cormpiler | Parameters | Directories | Build Gptions| Makefile |‘u"ersior1 info|

[ Use custem Makefile (de not generate a Makefile, use this one)

Customizing the Makefile Include the following files into the Makefile
The makefile has two main
targets, ‘all' and 'clean’.

‘all' depends on all-before and 4
all-after. all-before and all-after
gets called before and after the
compilation process respectively,

‘clean’ depends on the target
clean-custom, which gets called
before the cleaning process,

Alter the Makefile's behavior by
defining the targets mentioned,

Replace Add Delete Delete Invalid

[ W/ 0k | XCancel | [ 2 Help |

wxDev-C++ automatically creates a MingW Makefile for taking care of the
building process. If you are experienced with makefiles and want to add other
lines, you can do it here. Or, you can create your own custom makefile and have
the IDE use the custom makefile rather than the auto-generated one.

Version Info sheet :



- ld Project Options g ﬁ1
Project Profile: | MingW/ 34.2 + | (4[] [ &)

| General | Files | Cormpiler | Parameters | Directories | Build Options | Makeﬁle| Version info

[[lInclude version information in project

Version details Additional information
Major: 0 |j File Description
Minar: 1 |j File Version
Product Mame N
Release: |1 = .

S |j Product Version
Build: 1 |j Original Filename
Language: |English (United States) Internal Name

Company Mame
Build number increment Legal Copyright
i@ Don't Auto-Increment build number Legal Trademarks

Auto-Increment build number on cor
Auto-Increment build number on reb

o] [(Xona] [ 2epn]

You can specify version information for your program here. This info shows up
when you right click on the executable's icon and select "Properties".
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Linking libraries with your project

A little history :

MingW/GNU

Library filenames under the GNU system are in the form [ibNAME.a (where
NAME is the name of the library, like wsock32).

For example, if you want to use the wsock32 (winsock) library, the filename will
be libwsock32.a

The gcc parameter for linking a library is -NAME, so for linking with the
wsock32 library we would give GCC the —lwsock32 parameter.

MS VC++

MS libraries are in the form NAME.lib (where NAME is the name of the library,

like wxmsw28). MS VC uses the entire name so, for example, linking the
wxWidgets 2.8.9 library would be wxmsw28.1ib.

Linking your library:

Click on Project menu then on Options. Now click on the Parameters sheet.



ﬁ Project Options (X

Project Profile: | MingW/ 34.2 ~ | () () () &)
| General | Files | Cormpiler Parameters | Directories | Build Options | Makefile | Yersion info|
Cormpiler: C++ compiler: Linker:
-fno-exceptions # | | -fno-exceptions - -mwindows -
-fno-pec-struct-return || | -fno-pece-struct-return || | -lwsemswi28 i
-fstrict-aliasing _ || | ~fstrict-aliasing A -wernsw2E_gl
-Wall = | -wall 3 - bwetiff £
-D_WXMSW_ -D_WXMSW_ -lwxjpeg |
-D_GMNUWIN32__ | | -D_GNUWIN32__ — | | -lwxpng g |
-D__WINAS_ = | | -D_WIN95__ = | | -lwezlib |
1 } 1 } -Iwregex
-Iwexpat
Preprocessor Definitions: -lkernel32
_WHXMSW__ - -luzera
_GMNUWINZZ_ -lgdi32 -
_WINI5__ P b
. ) | L Add Library or Object |
[ /Qk ][ xgancel] [ ?ﬂelp ]

In the Linker edit box, you can specify as many libraries as you need. You can
also pass the complete filename of the library.

Example : —lm —lwsock32 c:\libs\mylib.a c:\objs\myobj.o

% Add Library or Object | ¢,

You may also use the Add Library or Object button [
select your library from a list.
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Compiling and linking process

How does the compile and link process works ?

The build process can be generally divided into four steps :

1. Preprocessor : expands macros and include files in your source.

2. Compiler : transform your source file into assembly code (a processor
language that's human readable)

3. Assembler : takes the assembly code and generate machine-readable code
(binary object code)

4. Linker : assembles and resolves object codes together to create a single
executable.

How to do this in wxDev-C++ ?

Just go to the Execute menu and click Compile # (shortcut : Ctrl+F9), and
wxDev-C++ will take care of the 4 build steps.

Look at the bottom panel of wxDev-C++, you should get something like this :

[ Compiler | 5 Resources ] Compile Log | [ Debug | 2 Find Results | *& To-Do List |
Information: Compile Log:

Total Errors: |3 Compiler: Default GCC compiler -
Size of Output ,73281541 bytes G204 K E;Ellch:;EgM:ﬂk:;iec.le(a:H\Users\tony\Documents\Programmlng\Junk\Makeﬂle.wm
rm -f Objects/MingW/Projectl App.e Objects/MingW/Projectl Frmn.o Objects/MingW/Project]_private.res
Output/MingW/Projectl.exe
g++.exe -c Projectl App.cpp -o Objects/MingW,/Projectl App.o -I"C:/Program Files/Dev-Cpp/include” -
I"C:/Program Files/Dev-Cpp/" -I"C:/Program Files/Dev-Cpp/include/3rdparty/wa/plotctrl” -I"C:/Program Files/Dev

54:1 Compilation successful; Compilation took 10 seconds

This log window shows you what wxDev-C++ is doing (the program it executes,
the files it is creating, ...).

If your program compiled, you will see the message ‘Compilation successful’
in this window.

If compiling or linking fails, you will see a list of the errors on the bottom panel :



| Compiler 1 x

» Compiler | 25 Resources | i Compile Log | (0 Debug | J& Find Results | *# To-Do List |

Line File Message
Ci\Users\tony\Documents\Pregramming\junk\ProjectlFrm.cpp  In member function “veid Projectl Frm::CreateGUIControls()":
a1 ChUsers\tony\Documents\Programming'junk\ProjectlFrm.cpp  i' was not declared in this scope
a1 Cih\Users\tony\Documents\Programming'junk\ProjectlFrm.cpp  [Warning] unused variable 't'
ChUsers\tony\Documents\Programming'junk\Makefile.win [Build Errer] exe: ** [Objects/MingW/ProjectlFrm.o] Error 1
79:5 Insert 89 Lines in file

You can directly jump to the line in your code where the error appears by
double-clicking on item.

Note, the GNU/MingW Makefile system that we use should detect any files that
have been changed between builds and only re-compile those files. However,
there are some times when you may want to just force the Makefile system to
rebuild everything in the project. To do this, just go to the Execute menu and
Rebuild All (shortcut: Ctrl+F11). Rebuild all is equivalent to calling Clean and
then Compile.
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Executing your program

The Basics

Executing your program is as simple as clicking on the Execute menu, then Run
(3 (shortcut : Ctrl+F10).

You can also use Compile and Run " (shortcut : F9) to build your program and
then executing it.
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Introduction to debugging

All developers make mistakes, but some mistakes are harder to detect than
others. Compile-time mistakes are usually the easiest to spot because wxDev-
C++ will provide a list of those errors (including line numbers and suggested
corrections) in the Compiler Output window. Runtime errors (or "bugs") are
more insidious because the developer has no way of knowing what line of code
caused the dreaded infinite loop or "Access Violation" or "Segmentation
Fault" or "Blue Screen of Death". Thus debuggers were created to help
developers investigate their program while it is running.

A debugger is a program that runs your program inside of it. It keeps track of
your program's functions, variables and instructions. It is capable of pausing
your program at a given moment (aka breakpointing), allowing you to view (and
even modify) the values of your variables at that moment, and then continuing
the execution of the program either one instruction at a time (stepping) or to the
end of execution. You can set breakpoints anywhere in your code : once your
program reaches that code at runtime, the debugger will pause your program
and let you examine its variables at that time.

This tutorial explains the use of the MingW GNU debugger (gdb). It can only
be used with the MingW gcc compiler. Note that gdb is intended to be a
command-line interface. It runs as its own shell allowing the user to run gcc-
compiled programs from within that shell. All we do in wxDev-C++ is send
messages to the gdb shell and parse the output as it occurs.

With gdb (as with all debuggers), we can:

specify places within the program to halt execution (aka breakpoints)
step through the program one line of source code at a time

view the values of variables in realtime as the program executes
evaluate the memory stack when a program throws an error

Note that a web search will reveal many gdb tutorials out there that are far more comprehensive than
one in terms of scope (for example, http://dirac.org/linux/gdb/). Please consider and review them if yo
want to learn the in's and out's of using gdb.



http://www.gnu.org/software/gdb/
http://www.mingw.org/
http://dirac.org/linux/gdb/

There are, in fact, other graphical programs, which also use gdb in a similar manner. For instance, th
Display Debugger (ddd) is a popular GUI interface for gdb debugging. You may, in fact, prefer to use
3rd party programs instead of the built in wxDev-C++ interface.



http://www.gnu.org/software/ddd
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Example Program to Debug

We're going to explain the debug process by working through an example.
Although we are limiting our discussion to the gdb debugger, the same example
could be used for other debuggers.

To create our example debug project, go to the File menu and select New and
then Project. The new project dialog will be displayed.

Mew project &J

| Baﬂc|

H o @B E P

Emnpty wxWidgets  wxWidgets Console  Static Library DLL
wxWidge.., Dialog Frame Application

Description:

Project options:
Marne: " C Project » C++ Project
Projectl [ Make Default Language

Select the Console Application from the window. We'll name our project
"sampleDebug". You'll notice that a new project will be created with a skeleton
C++ code called main.cpp. Replace the C++ code in main.cpp with the
following code:

main.cpp

#include <cstdlib>
#include <iostream>

using namespace std;




float fGlobal = 1234.56;
void test2(int* iTest2a, int iTest2b)
{
char chTest2 = 'r';
*iTest2a = iTest2b;
printf("Finished test2\n");
3
void test()
{
int iTesta, *iTestb; /* Put a breakpoint here */
test2(&iTesta, 5);
printf("iTesta = %d\n'", iTesta);
/* The next lines will cause a runtime error
since iTestb never gets initialized */
/*
test2(iTestb, 3);
printf("iTestb = %d\n", iTestb);
*/
3
int main(int argc, char *argv[])
{
float fMain = 3.1415;
test();
printf("Press any key to continue...");
getchar (); /* Pause the program from exiting */
return EXIT_SUCCESS;
3

Remember to save the project after you've replaced the contents of main.cpp.

This sample project will demonstrate the concepts of functions, local and
global variables, breakpoints, and backtraces. Note that lines 24-27 are currently

commented.

/*

test2(iTestb, 3);

printf("iTestb = %d\n", iTestb);
*/




These lines will not cause an error during compile-time (i.e. the Mingw gcc
compiler will create an executable with no reported compile errors), but it will
cause a core dump at runtime due to the use of the uninitialized variable iTestb.

In the next few sections, we'll put our sampleDebug project to good use
explaining how to use the debugger...
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Debugging your program

Launching your program into the debugger is easy.
Just go to the Debug menu and click on Debug ( * shortcut : F8).

If you do not have debugging information set in your project, wxDev-C++ will
ask you if you want to rebuild your program with this information enabled. You
can manually select that option in Compiler Option in the Linker section.

Project Options F7|

Project Profile: Pru:u!:ile 1 >

ceneral | Files | Compiler | parameters | Directories | Build Options || Makefile | vVersion info

MOTE: These settings will override the global Compiler Options affecting this project only,

Campiler; Default GC2C campiler b |
Z compiler; | Link. an Objective C program Mo [
4+ compiler: | [ Generate debugging infFormation ies j: }
Cods Generation Do not use standard system startup files or libraries Mo
Zode profiling :

. Strip executable Mo
Linker:
[+ Opkimization
[ o Ok l [ x Cancel ] [ ? Help ]

Note that the executable size has grown because the compiler has added
additional information that the debugger accesses during runtime. After your
project has been rebuilt with the debugger information included, you can click
Debug again.

The debugger has now loaded your program and runs it.



Debug
[ Compiler | iih compile Log (7] Debug | ,:"' Find Results | “& To-Do List |
Backtrace | Local Yariables | Threads | Watches | Qutput

Send command ko GDE

Output to Display. .

"Reading sywbols from C:hyvyi\Doounents and Settingsi OO E4V My

Documernt s %W 0+ sap LeDebuag 4 Oatpuat O Ming o W sanp leDebug. exe. o 0"

Output to Display. .

"done . \n"

Output to Display. .

"[New Thread 1340_0x17c]'n"

Current Thread ID = 1

Thread:

id="1" tcarget-id="Thread 1940_0x17c", frame={lewvel="0",addr="0x00401453", func="main",args=
[{name="argc" ,walue="1"}, {name="argqv" ,value="0x3Zc20"}], file="nain. cpp", fullname="C: /Docunents and
Settings /B My Documents/C+t/sanplelbebug/main. cpp" ,line="34"},state="stoppad"

Thread I = 1

Purnming thread 1

Stopped - Exited normally

Debugger closed.

What happened? Well, as the Debugger Output window shows above,
wxDev-C++ started gdb and ran your executable called "sampleDebug.exe".
The program had no errors and no breakpoints and so it exited normally.

Since the program exited normally, this output is probably only interesting if you

are familiar with gdb.
You will also have seen your program run in a console window like this

= C:\Documents and Settings\R\My Documents\C + +\sampleDebug\Output\MingW\sampleD

Finizhed test2
iTesta = &
Preszz any key to continue...




You can also send commands directly to the debugger by using the "Send
command to GDB" edit box just above the output. If you do not know gdb, you
can type help to display a list of commands.

You can see (almost) all of GDB's output by turning on Verbose Debugger
Output in the Debug menu.

Remember that wxDev-C++ is really just running a shell that passes these
commands to the debugger and reads the output returned. You could re-create
the same commands by using gdb from within a DOS shell.

In the next sections, we'll cover several useful (and more interesting) aspects
of the debugger :

Breakpoints

Stepping through your code
Watch variables
Backtracing

Using the CPU Window
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Setting Breakpoints

You can use breakpoints to pause your program at a certain instruction (i.e. at a

line of code).

To add a breakpoint, first select the line of code where you want to pause by
simply positioning the text cursor on it. Now,
Toggle Breakpoint (shortcut : Ctrl+F5). Clicking on the gutter (at the left of the

click on the Debug menu, then on

editor) in front of your line will have the same effect. You can set multiple

breakpoints. Clicking on the checkmark in the gutter will remove the breakpoint.

Note that if the breakpoint is set, the line will be highlighted red and a

checkmark will appear in the left gutter.

maMmppl

6 float £Global = 1234.56;

7

8 void test2 (int* iTestZa, int iTest2b)

?{
18
11
12
1l2] B
14
15
16
17
18
17
28
21
22
23
24
25
26

char chTest2
*iTestZa
printf ("Finished test2\n"™):

III,:
= iTest2b;

volid test ()
{

int iTesta, *iTestb; /+

test2 (£iTes=sta, 5):

printf("iTesta = %d\n"™, iTesta):

----- =
nauwayr

m

Put a breakpoint hers */

Now re-run the debugger ( * shortcut: F8) . wxDev-C++ will run your program

via the debugger and will warn you that your
changing the line color to blue.

breakpoint was reached by




main.cpp

6 float £Global = 1234.56:; -
7
8 void test2 (int* iTestZa, int iTest2b)
? ¢
18 char chTest2 = 'r';
11 *iTeat2a = iTes=st2b;
12 printf ("Finished test2\n"):
13 @
14 =
15 wvoid test()
16 {
/]
i8
19 test2 (&iTesta, 5): M
28 printf("iTesta = %d\n"™, iTes=sta):
21
22 * The next lines will cause a
23 since iTesth never *
24 £
25 test? (iT=sth, 3
26 printf("iTesth = #d\n", iTesth b

In the next steps we'll see how to examine the variables and step through the
program's execution.
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Stepping Through Your Program

Once a breakpoint has been reached, you can step into the code of your
application in different ways :

e Next Step = (shortcut : F7) : The debugger will execute the next
instruction (i.e. line of code) and pause

e Step Into = (shortcut : Shift+F7) : The debugger will execute the next
instruction (i.e. line of code) and pause. If that instruction is a function call
it will jump into the function and future steps will go line by line through
that function until it returns to the line that called it.

e -exec-finish™: The debugger will resume execution until the current
function is exited.

e Debug/ Continue * (shortcut : F8): The debugger will start or continue
the execution of your program until another breakpoint is reached.

If your program is still paused at the breakpoint, try hitting F7 to continue to the
next step. You'll note that the cursor in the source code moves down to the next
line of code and highlights it in blue. The breakpoint returns to its red highlight.

maMmppl

12 printf ("Finished test2\n"): -
1535 }
14
15 void test()
16 {
& 17 int iTesta, *iTestb; /+* Put a breakpecint here */
i8
19
g 28
21

22 + The next lines will canse a reniime errcor
23 since iTestbh newv

24 .

25 testZ (iTesth, 3)

26 printf("iTesth = #d4d\n", 1Testhb

27 *

28

LrLr ]




If you keep hitting F7, the debugger will continue executing the program one
line at a time until it reaches the end. Note that this is very useful in sections of
your code where you think there may be logic errors or infinite loops. You can
essentially slow the program execution down and view each instruction as it
happens.
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Watching variables

One of the most interesting aspects of debugging is the possibility to display
the value of your variables at a given time. This way you can be sure your
variable (e.g. a counter index) has the value you would expect.

wxDev-C++ is able to conveniently show you the contents of your classes,
strings, structures/unions, arrays and other variables in the Debug Local
Variables window:

[ Compiler | il Compile Log (T] Debug | ;:"' Find Results | & To-Da List |
Backtrace | Local Variables | Threads | Watches | Output

Mame Walue Location

iTesta 5"
iTesth "0x77c35094"

Note that in the above window, iTesta has already had its value set to "5", but
iTestb has not been set (the value will be random and depends on what data is at
that pointer at that given time).

Now keep this Local Variables window open and re-start the debugging. You
should be able to "step through" the code after the breakpoint (discussed in the
last section) and watch the iTesta variable change from a random value to "5".

Adding Watchpoints

Watchpoints are like breakpoints that are triggered not by a particular line of
code, but by the change in value of a particular variable in code. For example,
let's say that you've got a large program and think that your variable icount is
being changed unexpectedly. You can set a regular breakpoint (at any line
number), run the debugger to the breakpoint, and then add a watch to iCount.



The debugger will then always break whenever the value of icount changes.

To set a watchpoint, add a normal breakpoint to your code and run the debugger.
On the Debug window, click on the Watch tab. Then, click anywhere within the
Watch tab space. An Add Watch (shortcut : F4) menu should appear.

F® fdd Watch  F4

Clear all

Once you select Add Watch, a dialog box should appear:

[ Modify value &F

Variable to modify:

[v Break on Write
[ Break on Read

/Qk | xgancel|

L. =]

Type the name of your variable in the dialog, and press OK. If you select a
word in the current source file and press F4, it will add a watch of the selected
text without asking for a variable name. A breakpoint can be generated when the
value of the variable is written, read, or both.

Once a watchpoint variable is set, it will continue to be monitored in future
debugging runs. You can also modify the value of your watched variable at any
time during debugging by right clicking on the variable name in the Debug
Watch window and selecting Modify value. Note that you are changing this value
outside of your source code. The next time you run the debug, the value you
entered is lost and the program executes normally.



Important Notes:

e When using pointers to structures or classes, if you want to display all the
members of variable my_pointer then you need to watch *my_pointer (‘*’ is
the value-operator). Watching only my_pointer would just display the
address contained in my_pointer.

e Sometimes the debugger may not know the type of a pointer, and cannot
display all of the members of the pointed structure or class. You can bypass
this problem by casting your watched variable. For example, if the
debugger cannot show the contents of my_pointer of type MyPointer, you
could try adding the watch variable: *(MyPointer *)my_pointer

e If you are watching a wxString variable, you might find that when the string
changes, the debugger stops inside one of wxWidgets' string functions and
pressing F7 has no effect. The solution is to set an ordinary breakpoint on
the next line and press F8 to continue to the new breakpoint.

This happens because GDB is a general-purpose debugger and it doesn't
know that you are not interested in the internal workings of wxWidgets. It is
normally seen as undesirable behaviour but it is not a fault.
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Backtracing

Backtracing is the debugging concept that tells you which functions were
called before reaching a breakpoint or an interruption (like an access violation or
other runtime error).

Let’s do a simple test. Move the breakpoint in your sampleDebug project to the
printf line within the test2 (line 12). Then, re-run the debugger (shortcut: F8).
If you look at the Debug window in the Backtrace tab, you should see something
like this:

Compiler Compile Log Debug | 2 Find Results | ™2 To-Do List
1 L

Backtrace | Local Variables | Threads | Watches | Cutput

Function Arguments File Line

test2 main.cpp 12
test main.cpp 19
main main.cpp 33

This correctly shows the list of functions that have been called (since the start
of the program) before reaching the breakpoint. Clicking on a function in this list
will bring you to its implementation in your source code. So, for example, if you
click on test, the IDE will take you to line 19 in the source code.

Now uncomment lines 24-27 in the function test. When you try to debug this
time, the program will eventually cause an access violation and end. The IDE
should display which line triggered the error and the backtrace should display
the functions called to reach it.
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Using CPU window

wxDev-C++ provides a CPU window to expert developers who want access to
the status of CPU registers, memory and instructions.

To show the CPU window, wait for a breakpoint or interruption to raise in your
program and go to the Debug menu, then click View CPU Window. A window
similar to this will appear, but the memory pane will be blank:

— AR

Disaszembly ¢ Registers
Source File: |main.cpp ! Riefresh ] Register Walue

File: main.cpp A Ean

Line: 9

Function: _Z5test2Fi o 07741 80f

0x00407 3ce 1] push Eebp eds w7 7ch1bya

0=00407 3k 1 mow  XespXebp

D040 3d1 3 sub  $0x8 %esp eb DuFfde000

Line: 10 esp (002310

E::WDBEZIJI-IE-I]'I 3d4 B movh $0=72 -0u1[%ebp] . 002328

0=00407 343 10 mivv  0xB[%ebp)Zed: esi (00870073

0x004013db 13 mov  Oxcl%ebp).feax .

0:004013de 16 mov Xeaw(Zeds) ] Ll

Line: 12 Eip (w00401 407

0=00407 320 18 mowl  $0x444000 [Zezp]

000401 327 25 call Cxd16530 <printf> flogs AL

Lire: 13 cs 00000001b

0x00401 Jec a0 leave

0+00401 3ed 31 ret i Sl

| ds (00000023

Memory es (00000023
Address: _&ChTE‘ﬂtz Count; .54 fe OWO0000030

Ox00Z3FFO0 72 Z8 ff Z3 00 07 14 40 00 g3 (00000000

0x00Z3FFl0 24 ££ 23 00 05 00 00 00 22 £f Z3 00 e0 ££ 22 00 ¢ £

0x0023FFZ0 54 5o o3 77 05 OO0 00 00 58 £f 23 00 53 14 40 00 % w

Ox00E3FF30 42 4e c3 77 al cf 40 00 ald cf 40 00 41 14 40 00 BN w

0x00Z3FF40 a0 cof 40 00 57 00 Ec B

On the top left, you can find the assembler instructions of the current function.
You can display the assembler code of any other function by typing its name in
the Function field, then pressing the Enter key.

On the bottom left is the Memory pane, which you can use to display the
contents of memory. You can view any accessible* area of memory. For
example, say we want to see where the character chTest2 is stored. (You will



need to step through the program and stop at line 12 to see this example). Type
"&chTest2" into the address box and click "Refresh". The number '72" and the
character " will appear. This is the value of chTest2 in hexadecimal and as a
character. Change count to 64 and refresh. Now you will see chTest2 and the
following 63 bytes displayed, in hexadecimal in the left-hand block and the
corresponding characters in the right-hand block. You can obtain the address
where chTest2 was stored by reading off the address and counting columns to
the first value (GDB converted what you typed in the address box to the numeric
address, you are likely to see a different address to that shown here). You can
directly type addresses in decimal ('2359047") or hexadecimal ('0x23FF07")
format as well as indirectly ('&chTest2").

* Some memory areas are inaccessible and cannot be displayed.

On the right, are the contents of the CPU registers.
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Debugging multi-threaded programs

The GDB Debugger manual describes multi-threaded programs:

" ...a single program may have more than one thread of execution. Th
of threads differ from one operating system to another, but in gener
single program are akin to multiple processes — except that they sha
(that is, they can all examine and modify the same variables). On th
thread has its own registers and execution stack, and perhaps privat

Debugging a multi-threaded program is broadly similar to debugging a single-
threaded program, however a number of points must be borne in mind:

e A breakpoint may be set in any part of the program in the normal way. If the
breakpoint is set in a function or method that was or will be started as a
separate thread, then execution halts as normal when the breakpoint is hit. If
the function or method executes in several threads, then execution halts
each time the breakpoint is hit, no matter which thread it is in.

e When a thread stops, usually because a breakpoint or watchpoint is hit, then
all currently executing threads stop. Only the thread that initiated the stop is
guaranteed to stop at a source line. The other threads may stop anywhere,
including part-way through a statement.

e The thread that initiated the stop becomes the currently active thread and
the focus of debugging.

e The currently active thread is marked with an asterisk *' in the Threads tab.

e When a thread is started with "Debug" [F8], "Next Step" [F7], "Step Into"
[Shift+F7] or any other command that causes execution to begin, ALL
stopped threads will re-start.

e A single step might not complete. It is possible for a breakpoint or another
cause in another thread to halt execution before the first thread completes
the step you requested.

e It is not possible to separately identify watched variables that have the same
name, but which are in different threads; hence the program will stop when
any instance of the watched variable changes. However, the thread in which
the watched variable changed will become the current thread, and both the
Local Variables tab and the Watches tab will show the values of the
variables in that current thread.



e Unless you examine memory directly, the CPU window also operates on the
current thread. Unlike Local Variables, Watches and Threads, the panes of
the CPU window do not refresh automatically and you must click Refresh
on each pane as appropriate.
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Integrated Templates

wxDev-C++ uses a template system to allow the user to more easily create
specific projects. By this point you've encountered templates without knowing it.
When you select File, New, Project on the IDE menu, the project type options
listed in the dialog box (e.g. Console application, wxWidgets frame, etc.) are
preset templates.

Mew project &J

| Baﬂc|

o 0 B3 @ @
Emnpty wxWidgets  wxWidgets Console  Static Library DLL
wxWidge.., Dialog Frame Application

Description:

Project options:
Marne: " C Project » C++ Project

Projectl [ Make Default Language

Templates usually include two components:

1. A set of source files - These source files contains the minimal amount of
code needed to build the application

2. Project file - A preset project file (extension .dev) containing all of the
compiler and linker options necessary to build the application.

Templates are usually stored within the Templates subdirectory under the
wxDev-C++ installation directory. Let's look at a simple example of a template
from that directory.

Templates\2-ConsoleApp.dev




[Template]

ver=3

Name=Console Application

IconIndex=1

Description=A console application (MSDOS window)
Catagory=Basic [Project]

UnitCount=1

Name=Console App

ProfilesCount=2

ProfileIndex=0

[Unito]

CName=main.c
CppName=main.cpp
C=consoleapp_c.txt
Cpp=consoleapp_cpp.txt

[Profile0]
ProfileName=Mingw 3.4.2
Type=1

ObjFiles=

Includes=

Libs=

PrivateResource=
ResourceIncludes=
MakeIncludes=

Compiler=

CppCompiler=

Linker=

PreprocDefines=
CompilerSettings=0000000000000000000000
Icon=
ExeOutput=Output\MingWw
ObjectOutput=0bjects\MingWw
OverrideOutput=0
OverrideOutputName=
HostApplication=
CommandLine=
UseCustomMakefile=0
CustomMakefile=
IncludeVersionInfo=0
SupportXPThemes=0
CompilerSet=0
compilerType=0




[Profilel]

ProfileName=MS VC++ 2005

Type=1

ObjFiles=

Includes=

Libs=

PrivateResource=

ResourcelIncludes=

MakeIncludes=

Compiler=

CppCompiler=

Linker=

PreprocDefines=
CompilerSettings=000000000000010000000ONCONEONEOEOEOEOLOO
Icon=

ExeOutput=0utput\MSVC++2005
ObjectOutput=0bjects\MSVC++2005

OverrideOutput=0
OverrideOutputName
HostApplication=
CommandLine=
UseCustomMakefile=0
CustomMakefile=
IncludeVersionInfo
SupportXPThemes=0
CompilerSet=1
compilerType=1

1
(©)

The template above sets up a generic console project (i.e. a DOS shell
application). In the [Project] section, one source code unit and two compiler
profiles are defined. The source code unit is further specified as consisting of a
C++ skeleton code which is derived from the file consoleapp_cpp.txt and
renamed as file main.cpp. The two profiles are further specified as a MingW
gcc and a MS VC++ 2005 compiler profile.

Using a text editor, you can easily create your own templates for use with
wxDev-C++. However, wxDev-C++ can also automatically create templates for
you based on your existing projects. For example, let's say that you frequently
like to use the Boost, wxWidgets, and SQLite libraries in your projects. You'd
like to create a Boost/wx/Lite (let's call it "BWL") template that sets up all of the
includes, switches, and base code so that whenever you create a new project, you



can have the template handle the basic setup and jump right into the main
programming. Here's how to create your BWL template:

1. Create the most basic project you can that correctly compiles, links, and
executes using the Boost, wxWidgets, and SQLite libraries.

2. On the File menu select New and then Template. A new template window
Mew template from project &J

Mame: |Cu5tu:|rr1 project 1 j
Description: |Thi5 is @ custom project.
Category: | j

Mew project name: |Cu5t|:|rr1 project

Icons:

1
Emp?Templateicun
_— |

Emp?New project icon |

| Cancel |
dppears. .

3. In the Template Info tab, you can specify the name, description, type, and
icons associated with this template.

4. In the Files tab, you can select which files of the current project you want to
include in the template. Whenever you create new projects with this
template, those files (and their contents) will be generated in the new
project.

5. In the Extras tab, you can specify extra compiler and linker
switches/parameters that you wish to include in the template for new
projects.

Once you've filled out all of the necessary information for your new template,
hit the Create button and save the template with a unique name (e.g. BWL-
template.dev).

To test your new template, close the current project and try to create a new
project (File, New, Project). Your BWL template should appear as an option in



the list and can be used like any other.
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Getting and Installing Packages

wxDev-C++ makes use of Dev-C++'s DevPak system for updating and
improving the program. For example, if you need to use SQLite or OpenSSL in
your programs, there are probably DevPaks out there that will allow you to
automatically add the header files, libraries, and templates needed to easily add
these functions to your programs. DevPaks are also used to automatically update
the IDE or the RAD.

What's in a DevPak?

A DevPak is really just a compressed package containing files that will be
copied to your computer. The DevPak creator first creates a file (extension
.devpackage) that contains what files to include in the DevPak and where to
copy them on the target computer. Those files are then added to a single file
using the tar archiving tool (extension .tar) and that single archive file is
compressed using the bzip2 tool (extension .tar.bz2). The single, compressed
archive file is given the extension .devpak, but it is actually just a tar'd, bzip2'd
archive similar to other packages you may have downloaded. Although you can
create DevPaks manually, the developers of Dev-C++ made the process even
easier by providing a GUI for making DevPaks called PackMaker. You tell
PackMaker what files to include in your DevPak and in what directories to
install those files, and PackMaker handles the archiving for you.

Where do I get DevPaks?

The easiest way to get DevPaks is to use wxDev-C++'s web update feature.
WebUpdate searches a list of DevPak servers and tells you if the ones online are
newer than the ones you already have installed. To activate WebUpdate, go to
the Tools menu and select Check for Updates/Packages.


http://devpaks.org/
http://en.wikipedia.org/wiki/Integrated_development_environment
http://en.wikipedia.org/wiki/Rapid_application_development
http://en.wikipedia.org/wiki/Tar_%28file_format%29
http://www.bzip.org/
http://en.wikipedia.org/wiki/Graphical_user_interface

#J WebUpdate ==

: r’ Welcome to WebUpdate for wxDev-C++

Select DevPak server

|MDE‘J-C++ DevPak server Li gk Check for Updates

Groups: Selection: 0 files selected, 0 KB (D Bytes)

|<A|| groupss j Status: Disconnected

Available updates list:
Update Version I Installed | File size | Date i
O 12 67 KB 2008-03-07 12:10 |E |
[ Dev-C++ Help file 20 7.0 1802 KB 2008-03-0919:30 B
[Jweiwidgets MS VIC 2005 2849 8206 KB 2008-09-27 15:00
[JwxWidgets Contribs M5 VC 2005 2849 1725 KB 2008-09-27 15:00
[ wexwWidgets Extras MS VC 2005 2849 2536 KB 2008-09-27 15:00 10

1 | 1]

|| Eile description:

Bzip stream for wxWidgets (wxbzipstream). Works just like watarstream except that it uses Bzip
COMmpression,

| W Close |

—

You can select the online DevPak server in the dropdown box and then click
the Check for Updates button to download a list of available DevPaks on that
server. Note that we suggest using DevPaks from the wxDev-C++ server because
we know they'll work with the wxDev-C++ IDE. Other DevPaks may require
some manual intervention to get the correct paths for the compiler and linker.

Once you find a DevPak you want to download, click on the empty checkbox

to the right of its name and then click the Download Selected button at the

bottom, right of the window. The DevPak will be download from the webserver

and will begin the install process:



@. Installation Wizard

%D Dev-C++ Package Installation Wizard

wibzipztream installation procedure.

YWelcome to the Dew-C++ Package Inztallation “wizard. Thiz wizard will
inztall webzipstream 1.2,

Pleaze press Mest to continue with the installation, or press Cancel to stop
the inztallation now.

FPackage description

wi ztream with Bzip compression

» Welcome
1 eadme

Liz

Finizhed

About,.. | Mest » | | LCancel |

In the above case, I've selected the wxBzipStream DevPak to install. There's
usually a Welcome screen that explains what the package will install and screens
for the ReadMe and License files that typically come with packages. Continue
the DevPak installation by clicking on the Next button until you are told that the
DevPak has installed successfully. Once finished, our wxBzipStream library
should be installed on our computer and ready for use in our programming.

Managing DevPaks

e How do I know that my new DevPak really installed correctly?
e What happens if [ want to uninstall it?

To manage your DevPaks, the Dev-C++ developers created a DevPak
manager called PackMan. To activate PackMan click on the Tools menu and
select Package Manager.



@ Dev-C++ Package Manager (version 2.2.6)

Package View Help
k]
F & g & 53 4
Install  ‘erfy Remove | Help  About Exit
General | @ @ @ @ @
birtils Dev-C++ Help file Dew-CH+ goc-cone Qoo+
: examples
wibzipstream
@ @ 3 @ @
GMU Debugger Dew-CHt GNU Make mingw-runtime  Programming with Dew-C+
Language willey-C++ Templates
wi stream with Bzip *
Compression E E E ’E E E
win32api willey-C++ v idgets wedwidoets  wedwfidoets Extraz welwidgets Mingw
release candidate comman Contribs common comman g
wetwidoets  welwidoets Extras wedwidgets witwidgets M5 wivdidgets  wiwidgets Extras
Cantribz MinG... MinG' goc Samples W 2008 Cottribs 5 .. 5 WC 2008
Ready.

As you can see, the wxBzipStream package is shown along with the other
packages installed on my system. In the notebook page to the left of the screen,
you'll see that the General tab lists the name, version, and description of the
DevPak. If you click on the Files tab, you'll see a list of the files that are
associated with this DevPak and where they have been installed on your
computer.

veity To verify that the DevPak successfully installed all of its files to your
computer, select the DevPak's icon and click on the Verify tool in the toolbar. A
message box should appear telling you if any files that should be in the DevPak
don't appear on your computer in their correct location.



Remove To uninstall the DevPak, select the DevPak's icon and click on the Remove
tool in the toolbar. PackMan will delete all of the files from your computer that
were a part of this DevPak.
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Compiler Options

As the name implies, the Compiler Options dialog allows you to configure
global settings for the compilers you will use to build your programs.

To access the dialog, click on the Tools menu, then select Compiler Options.

! Compiler Options ﬁ
Compiler Set: |Defau|t GCC compiler j ﬂﬂ

Compiler l Settingsl Directories | Programs mWidgetsl

Cormpiler set to configure:
Compiler Type: |MingW j E
[ Usefast but imperfect dependency generation

Compiler Command Line
Add the following commands when calling compiler:

Add theze commands to the linker command line

Add theze commands to the make command line;

Compile Delay |0 =
= Default

x Cancel | ? Help
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Compiler Options

Compiler tab

Compiler Set

The first tab in the Compiler Options dialog allows you to specify the name of
your compiler set and any additional commands you wish to add to the compiler
or makefile instructions. Recall that wxDev-C++ allows you to use different
compiler sets to build the same project.

Note that the name of the compiler set is just a tag. It does not have to be the
name of the actual compiler you wish to use. For example, instead of the set
name "Default GCC compiler”, I can define a compiler set named "Best
compiler in the World 1", but use the compiler type of MingW (i.e. the MingW
gcc compiler). The buttons | %] @ allow you to add, delete, and rename a
compiler set respectively.

Remember that this configuration window will change the global settings used
by all of your projects with this compiler set. If you want to add custom
compiler/linker settings for a particular project and not affect other projects, then
you want to go to the Project menu and select Project Options.




Compiler Options &J

Compiler Set: |DefauItGCC compiler j ﬂﬂ

Compiler l Settingsl Directories | Programs MWidgetsl

Cormpiler set to configure:
Compiler Type: |MingW j E
[ Usefast but imperfect dependency generation

Compiler Command Line
Add the following commands when calling compiler:

Add theze commands to the linker command line

Add theze commands to the make command line;

Compile Delay |0 =
= Default

[

Compiler set to configure
Here, you actually specify which type of compiler you wish to use with this

compiler set. The default compiler that comes bundled with wxDev-C++ is
MingW gcc. We also support MS VC 2003, 2005, and 2008 compilers.

Add the following commands when calling compiler
Here you can specify additional command-line options to be passed to the gcc

compiler when compiling your project or file. Check the gcc manual for a list of
command-line arguments.

Add these commands to the linker command-line

Here you can specify options to be passed onto the linker (1d.exe).


http://gcc.gnu.org/onlinedocs/gcc/index.html#toc_Invoking-GCC

Compile delay

This option is present to provide a delay before compiling. Normally, you will
not use this. If make complains of the timestamp being invalid, try specifying a
delay here.

Use fast but imperfect dependency generation
By default, Dev-C++ will check all files and headers for dependancy

information, and update the makefile accordingly. If you find that it's taking too
much time, you can prevent this by enabling this option.
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Compiler Options

Settings tab

The compiler settings will, of course, depend on which compiler you are using
(in most cases Mingw gcc or MS VC). I'm only going to explain the MingW gcc
settings in this help file. However, Microsoft provides a very informative online
library if you need help with MS VC compiler settings.

Compiler Options L&J
Compiler Set: |Defau|t GCC compiler j ﬂﬂ
Compiler 5ettings l Directories | Programs wxWiu:Igetsl
¢ C compiler: Support all ANSI standard C programs Mo j
C++ compiler: Atternpt to support sorme aspects of traditic Mo
é----CDdE Generation  |Inhibit all warning messages Mo
é----Cu:u:Ie profiling Displays one error per line Mo
.. Linker:

&- Optimization

x Cancel | ? Help |

= Default

NOTE: A more in depth explanation of these compiler options can be found in
the gcc manual.

C Compiler

Support all ANSI standard C programs


http://msdn.microsoft.com/en-us/vstudio/default.aspx
http://gcc.gnu.org/onlinedocs/gcc/

Option -ansi: Will attempt to be as ANSI conformant as possible.
Attempt to support some aspects of traditional C pre-processors

Option -traditional-cpp : Will attempt to make the pre-processor behave as
traditional ones do.

Inhibit all warning messages
Option -w: No warnings will be displayed.
Displays one error per line

Option -fmessage-length=0 : Displays one error per line!

C++ compiler

Turn off all access checking
Option -fno-access-control
Accept $ in identifiers

Option -fdollar-in-identifiers: Will allow $ to be used in variable and function
names. Cannot be used with GCC 3.2.

Code generation
Enable exception handling
Option -fexceptions

Use same size for double and float



Option -fshort-double
Put extra commentary information in the generated assembler

Option -fverbose-asm: The intermediary assembler files generated will have
extra comments. Only useful if they're being saved (using the -S command-line
option).

Code profiling
Generate profiling info for analysis

Option -pg: Writes extra information into the generated program files to use with
the profiler. The profiler lets you see where maximum amount of the program's
execution time is being spent, so that when you're optimizing the program, you
optimize only the parts that make the difference. This option should be disabled
when building retail/final versions. It should be used only in debug builds.

Linker

Link an Objective C program
Option -lobjc

Generate debugging information

Option -g3: Writes debug information into the generate binaries. This lets you
debug it with the integrated debugger.

Do not use standard system startup files or libraries

Option -nostdlib: Do not use the standard system startup files or libraries when
linking. No startup files and only the libraries you specify will be passed to the


http://en.wikipedia.org/wiki/Objective-C

linker. The compiler may generate calls to memcmp, memset, memcpy and
memmove. These entries are usually resolved by entries in libc. These entry
points should be supplied through some other mechanism when this option is
specified.

Do not create a console window

Option -mwindows: Instructs gcc to build a Windows GUI application without a
console window.

Strip executable

Option -s: Remove all symbol table and relocation information from the
executable.

Optimization

Optimization can make your code execute faster, but requires more time to
compile.

Perform a number of minor optimizations

Option -fexpensive-optimizations: Perform a number of minor optimizations that
are relatively expensive. Enabled at levels -O2, -O3, -Os.

Further Optimizations

Here, you can select the optimization level.

Optimize

Option -O1: With -O1 (or just -O), the compiler tries to reduce code size and
execution time, without performing any optimizations that take a great deal of

compilation time.

Optimize more


http://gcc.gnu.org/onlinedocs/gcc/Optimize-Options.html#Optimize-Options

Option -O2: GCC performs nearly all supported optimizations that do not
involve a space-speed tradeoff. The compiler does not perform loop unrolling or
function inlining when you specify -O2. As compared to -O, this option
increases both compilation time and the performance of the generated code.

Best optimization

Option -O3: Optimize yet more. -O3 turns on all optimizations specified by -O2
and also turns on the -finline-functions, -funswitch-loops, -fpredictive-
commoning, -fgcse-after-reload and -ftree-vectorize options.
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Compiler Options

Directories tab

These are the directories the IDE will search when it is building your program.

r Compiler Options ﬂ
Compiler Set: IDefauIt GCC compiler j ilil

Compilerl Settings Directories | Programsl mWidgetsl

RN Libraries | CIncludes | C++ Includes | Resource Includes |

ChProgram Files\Dev-Cpp\Bin

Replace | Add [relete | Delete Invalid |%|

= Default |

x Cancel | ? Help |

Binaries
Specifies the locations of the compiler, linker, and other executables.
Libraries

Specifies the locations of the library files (*.a, *.dll, *.lib, *.def).



C includes

Specifies the locations of the headers (*.h) for C programs.

C++ includes

Specifies the locations of the headers (*.h, *.hpp) for C++ programs.
Resource includes

Specifies the location for the resource files (*.rc) for Windows programs.
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Compiler Options

Programs tab

- Compiler Options ﬁ
Compiler Set: |Defau|t GCC compiler j ﬂﬂ

Cu:umpiler] Settingsl Directories Programs lwxWidgetsl

You may want to change the programs filenames that are used in
Dev-C++ (for example when using a cross compiler) :

C compiler: |gcc.exe

C++ Compiler: |g++.exe

Make: |mingw32-make.exe

Resource Compiler: |wir1u:|re5.exe

||:III-.'-.-|ar:.ErE

Debugger: |gu:||::|.exe

all [38 |0 a8 [0 [aB D

Code Profiler: |gpru:uf.exe

x Cancel | ? Help |

= Default

Here you can specify the filenames of the different compiler executable
components. Note that wxDev-C++ uses the MingW make system for all of its
builds.
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Compiler Options

wxWidgets tab

This is where you can store the information about the wxWidgets libraries you
want to use. The information here will be used to change the values passed to
the linker in the MingW makefile. For the current example, the program would
be linked to to the library libwxmsw?28.a for gcc and wxmsw?28.1ib for MS VC.
If you update your wxWidgets libraries (or want to use your own libraries), then
you'll need to update this information in order to pass the correct library to the
makefile.

Compiler Options &J

Compiler Set: |DefauItGCC compiler j ﬂﬂ

Cu:umpiler] Settingsl Directories | Programs  wxWidgets l

Yerzion

Major: |2
Minor: |8

Release: |2

LA REN

o

Features
[ Unicode Support

[v Meonolithic Library
[ Debug Build

Library Type
{* Static Import Library
" Dynamic Library (DLL)

= Default
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Environment Options

General options tab

To access the Environment Options dialog, click on the Tools menu and
select Environment Options.

Envircnment Options &J
External programs l File Associations l CV5 Support l
General l Interface l Files & Directories

[v Allow only one instance of wxDev-C++

[ Create Backup Files

[ Minimize on Run

[ Show Teoolbars in Full Screen

r

[ Double Click to Open Project Manager Files

Auto Open Debug variables browser

™ All Project Files [ Watch variable under mouse
" Only First Project File [ Report watch errors

{* Mone

W Ok | X Cancel | ? Help |

Allow only one instance of wxDev-C++
Allows only one instance of the IDE to be running.
Create Backup files

If enabled, whenever you save a source file inwx Dev-C++, a backup copy will
be saved along with it. This backup will be overwritten on successive saves.



Minimize on run

If enabled, wxDev-C++ will minimize itself when you execute your program
from within it (using the 'Run' command under "Execute").

Show toolbars in Full-screen

By default, toolbars are hidden when wxDev-C++ is made full-screen. If this
option is enabled, they will be shown all the time.

Double-click to open project-manager files

If this option is enabled, you'll need to double-click on the nodes in project-
manager to open them in the editor. Otherwise, you would single-click.

Auto-open...

Here, you can choose what files are automatically opened in the editor when you
open a project.

Debug variables browser

If "Watch variables under mouse" is checked, variables under the current mouse
position will be created as watch variables during a debugging session.
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Environment Options

Interface
Envircnment Options &J
External programs File Associations l CV5 Support l
General Interface l Files & Directories

Mas Files in ReOpen Menu 10 -

Message Window Tabs: Top A

Language: English (Original) A

Theme: |New Look j

[ Mo splash screen on startup
[ Use XP Theme
[v Use Mative Docking Windows

Open/5ave Dialog Style Compilation Progress Window
¢ Windows 2k (sidebar) [+ Show during compilation
I~ Windows 9x [ Auto close after compile
7 Windows 3.1

VOok | Xcance | 2 Hebp

Max files in re-open menu

Here, you can specify the number of files wxDev-C++ keeps track of in the
Reopen menu. Older files are forgotten first.

Message Window Tabs

Sets the position of the message window tabs (Compiler, Resources, Compile
Log, Debug, Find, ToDo List)

Language



Select your language here.

Theme

Select the theme you want wxDev-C++ to use.

No splash screen on startup

If enabled, it prevents wxDev-C++ for displaying a logo when it starts up.
Use XP theme (WinXP only)

If enabled, it makes wxDev-C++ use Windows XP themes (bitmap title-bars,
buttons, etc.).

Open/Save dialog style
Here you can select the type of file open/save dialog you want to see.

Compilation progress window

Allows you to select whether you wish to see the compiler output log at compile
time and if you wish it to auto-close.
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Environment Options tab

Files and Directories

This is where you can modify the default directories that the IDE uses to store
configuration files, templates, and user data.

Envircnment Options &J
External programs l File Associations CV5 Support ]
General l Interface Files & Directories

Alternate Configuration File

[ ilse this alternate configuration file

User's Default Directory

Templates Directory

o

il

|Temp|ate5\

il

Icon Library Path

|Icu:|r15\

Language Files Path
|Lang\

Splash Screen Image
| i

/Qk | xgancel|

uq
I
m
s

Alternate configuration file

wxDev-C++ typically saves your preferences to a settings file (devcpp.cfg)
located in the user AppData directory. You can change where the IDE looks for
this settings file. This is useful if you want to have all of the IDE files in one
directory for portability. (Some users have been able to use wxDev-C++ on a
thumbdrive that they move from computer to computer without having to install
it on the computer).



User's default directory

Specifies the default location that the IDE uses (when creating projects, opening,
saving, etc.)

Templates

Specifies the location of the Dev-C++ project templates (the ones displayed
when you click on "New Project').

Icon library path

Specifies the location of the icons for use in your projects.
Language Files path

Specifies the location of the Dev-C++ language files.
Splash screen image

You can specify an alternate splash-screen bitmap here.
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Environment Options

File Associations tab

Here, you can select one or more file types which the IDE will associate itself
with, so that the next time you open an associated file in Windows Explorer,
wxDev-C++ will be opened up automatically and load that file.

Envircnment Options ﬁ
General l Interface ] Files & Directories l [
External programs File Associations l CV5 Support l [
File Types: [
v C Source File (*.c) [

C++ Source File (*.cpp)
C Header File (*.h) '
C++ Header File (".hpp)
Dev-C++ Project File (*.dev)
Resource Source File (*.rc)

5] Dev-C++ Template File (*.template)

& 5] 5] K] [%

Just check or un-check for which file types Dev-C++ will be |
registered as the default application to open them... {

n/ Ok x Cancel | ? Help |
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Environment Options

CVS Support tab

Concurrent Versioning System (CVS) is a way to store your project files and
keep track of any changes you (and other developers) make. It allows you to not
only backup your current files, but also to rollback to earlier versions of your
files and undo changes.

Envircnment Options &J
General l Interface Files & Directories ]
External programs l File Associations CV5 Support

CV5 Program File
== =

Compression Level
4 Y

w

[v LUze 55H instead of R5H

SOk | Xcance | 2 Hebp

CVS program file
Enter the name and directory of the CVS program executable.

Compression level


http://www.nongnu.org/cvs/

Specify the compression level to be used.

Use SSH instead of RSH

Use the SSH program to connect


http://en.wikipedia.org/wiki/Secure_Shell
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Editor Options

Editor options allow you to configure how you wish your source code to display
within the IDE. wxDev-C++ allows you to configure code formatting, line
numbers, code completion, syntax highlighting, and many other options that are
useful when coding large programs.

To access the Editor Options go to the Tools menu and select Editor Options.

Editor Options &J

l Displa}r] Syntax l Code l Class browsing

Editor Options:

[v Autc Indent [~ Enhanced Home Key

[+ Insert Mode [ Cursor Past EQOF

[ Use Tab Character [ Cursor Past EOL

[ Smart Tabs [ Double Click Line

[v Keep Trailing Spaces [v Find Text at Cursor

[v Backspace Unindents [v Scrollbars as needed

[v Group Undo [ Half Page Scroll

[ Insert Dropped Files [v Scroll Hint

[ Show hidden line characters [v Show editor hints

[v Ensure that file ends with newline

[v Highlight current line -

Caret Right Margin

Insert Caret Vertical Line = [v Visible

Overwrite Caret Vertical Line = _— E

[ Highlight matching braces/parenthes i = J

/Qk | xgancel | ?ﬂelp |
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Editor Options

General tab

Editor Options &J
GEWFE'I Displa}r] Syntax l Code l Class browsing
Editor Options:
[v Autc Indent [~ Enhanced Home Key
[+ Insert Mode [ Cursor Past EQOF
[ Use Tab Character [ Cursor Past EOL
[ Smart Tabs [ Double Click Line
[v Keep Trailing Spaces [v Find Text at Cursor
[v Backspace Unindents [v Scrollbars as needed
[v Group Undo [ Half Page Scroll
[ Insert Dropped Files [v Scroll Hint
[ Show hidden line characters [v Show editor hints
[v Ensure that file ends with newline
[v Highlight current line -
Caret Right Margin
Insert Caret Vertical Line = [v Visible
Ohwverwrite Caret lm Width Color
[ Highlight matching braces/parenthes i = J

/Qk | xgancel | ?ﬂelp |

Editor options

e Auto Indent - Automatically indents a new line according to the current
line's syntax

e Insert Mode - Text will insert at the current cursor position (not overwrite)

e Use Tab Character - Inserts tab character, otherwise inserts spaces

e Smart Tabs - When [Enter] is pressed, indents the new line with the same
combination of tabs and spaces as the previous line, otherwise indents the
new line with the most economical combination of tabs and spaces,
depending on the setting of Use Tab Character



e Keep Trailing Spaces

e Backspace Unindents - If a tab stands before the current cursor position, the
backspace key will remove it

e Group Undo - When undoing/redoing actions, handles all successive

changes of the same kind in one operation, otherwise handles one operation

at a time

Insert Dropped Files

Show hidden line characters - Displays hidden characters in the editor

Ensure that file ends with a newline

Highlight current line - Highlights the line at the current cursor position

Enhanced Home Key

Cursor Past EOF - Allows you to place the cursor past the end-of-file

character

e Cursor Past EOL - Allows you to place the cursor past the end-of-line
character

e Double Click Line

e Find Text at Cursor - If checked, the "Find" dialog will use the text at the
current cursor position as the search term.

e Scrollbars as needed - If checked, scrollbars will only be displayed if there
is text beyond what's visible in the window.

e Half Page Scroll

e Scroll hint

e Show editor hints

Caret

e Insert Caret - If text mode is set to insert, then use this caret graphic to mark
the current position.

e Overwrite Caret - If text mode is not set to insert (i.e. typing will overwrite
text), then use this caret graphic to mark the current position.

e Highlight matching braces/parenthesis - Highlight the matching braces in a
block of code

Right Margin
e Visible - If checked, a vertical line is displayed to denote the right margin in

the editor
e Width - Sets the line width marker



e Color - Color of the right margin marker
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Editor Options

Display tab
Editor Options &J
General D|5F|3}fl Syntax l Code l Class browsing l
Editor Font:
Font Size Tab Size:
Courier Mew j |1I:I j |4 ﬂ
Editor Font
Gutter
v Visible [v Line Murmbers
[ Auto Size [ Start at Zero
Iv Use Custom Font [ Show Leading Zeros
[v Draw with Gradient
Font Size Width
Terminal ~ | | |32 B
Gutter Font
o Ok | X Cancel | ? Help
Editor font

As the name implies, this allows you to select which font you wish to use for
the editor. It also also you to specify how many spaces are used for tabs.

Gutter
e Visible - The gutter is the left margin of the text editor. If this is checked,

the gutter will be displayed.
e Autosize - The width of the gutter will change to best fit the text.



Use custom font - Allows you to specify a gutter font that is different than
the text editor

Line numbers - If checked, it will display the line numbers of the text

Start at zero - Line numbers typically start at 1. If this box is checked, they
will start at 0.

Show leading Zeros - Left pads 0's to the line numbers (e.g. 0020) to make
all line numbers the same width.
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Editor Options

Syntax tab

Editor Options Li_E-J

[v Use Syntax Highlighting

Type: Enabled file extensions: |c;cpp;h;hpp;cc;m¢cp,
N
Character Color Speed Settings A ﬂ
Comment = Styles

Float [~ Bold

Hexadecimal [ Halic

IdEﬂtlfIEr I_ Underlined

lllegal Char

Mumber Foreground I |~
Octal - | Background -
a1 Syntax Previ

]

B2 #include <iostream>
B3 #include <cstdio>
B4 #include <conio.h>

TR

a5

A6 int main(int argec, char **argv)

a? ¢

me imt mrvmbhaare T30 - e

4 I

/Qk | xgancel | ?ﬂelp |

Syntax highlighting allows you to format your display of C/C++ source code
using different fonts, colors, and backgrounds. Note that the wxDev-C++/Dev-
C++ editor only knows C/C++ syntax highlighting and probably won't work for
other programming languages. The Type listbox allows you to configure each
programming language class (comments, assembler code, numbers, reserved
words, etc.) The Enabled file extensions text box specifies which file
extensions apply to these definitions. The highlighted code at the bottom of the

tab shows a preview of how C/C++ source code will be displayed with the
current settings.
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Editor Options

Code tab

This allows the user to define a menu option that adds code snippets while you
are programming. The idea is that if you have code that you frequently use (e.g.
a class or function that you almost always add to your programs), then you can
set up a menu selection that automatically adds this code to your current project
at the current cursor position.

. Editor Options Li_E-J
Generall Displa}r] Syntax Code lCIass I::lru:uwsing]
Tnserts | Default Source |
Menu Text Secti... | Description Add
Code
\/ Ok | x Cancel | ? Help |

To add a code snippet to the menu, go to the Tools menu and select Editor
Options. Then, click on the Add button. The Add Code Insert Entry dialog will
allow you to name the new menu entry and a description of what the entry will
do. Then, add the code snippet to the Code textbox. When you click the Ok
button, your code snippet will be added to the Edit menu under Insert. Selecting



that menu item will insert your Code into the IDE at the current cursor position.
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Editor Options

Class browsing tab

Editor Options L&J

Generall Displa}r] Syntax l Code  Class browsing

v Enable class browser

Class browsing l Completion l
Engine options
[v Scan local files referenced in #Finclude's

[ Scan global files referenced in #Finclude's

View options
[v Uze colors

[ Show inherited members

sample: | -47% Classl : class

-4 Class2 : class

/Qk | xgancel | ?ﬂelp |

The Class Browser is a hierarchical tree that displays all of the classes,
functions, global variables, and structures that are used in your project. It's a nice
way to graphically display the major players in your programs. The Class
Browser is displayed in the Project Inspector window under the Classes tab.

NOTE: Class browsing MUST BE ENABLED to use the wxDev-C++ visual
designer.

In the Engine options section, you can configure the class browser to scan
both local and global include files for their major players. If you chose to scan
for global include files, then you will also include in the class browser the
classes and functions from the 3rd party libraries you link with your program



(e.g. wxWidgets libraries, SQLite libraries, etc.).

In the View options section, checking the Show inherited members box will
cause the class browser to also display any classes from which your classes are
dervied. For example, if you create your own wxFrame class called myFramel,
the browser windowwould typically only show the members of that class that
you've specified in your project. With the Show inherited members checked it
will also display the members that were inherited from the generic wxFrame
class.
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Editor Options

Code completion tab

Editor Options &J

Generall Displa}r] Syntax l Code  Class browsing l

v Enable class browser

Class browsing Completion l

[v Enable code-completion
Delay (ms): |5':":| ﬂ

Background color v|

[~ Use code-completion cache

Files in cache:

Clear

1=
o
o

/Qk | xgancel | ?ﬂelp |

Code completion allows you to program C/C++ more efficiently. When
enabled, code completion will try to offer suggestions for completing your code
as you type it. For example, if you were working on a wxFrame project
and typed:

this->

in the source code, a dropdown box will appear offering properties and functions
that can complete the command. The Delay value in code completion specifies
the amount of time (in milliseconds) which a user must pause typing for the code
completion to be activated. For example, with a delay of 500, the user will have
to pause typing for 500 ms (or half a second) before the code completion



command is initiated; otherwise, the code completion will be skipped.

void ProjectlFrm: :CreateGUIControls ()

i
Do not add custeom code betwvesn
[ ms Creation Start and GUI Items Creation End
++ designer will remove them
custom code before or after the blocks

SAAAG0T Items Creation Start

int ALongNamedInteger;

wxInitAllImageHandlers () S/Initialize graphic format handlers

WxStaticBitmapl = new wxStaticBitmap (this, ID WXSTATICEITMAPI, wxl

ALongNamed

m

Variable int ALongNamedInteger

W=xEditl = IEditl™), wxPoimi
WxEditl->8 [EEH™) ) ) - B

WELTrraysSto
WxChoicel /LT (32, 178), wx!
WxChoicel- E

WxChoicel- -

rrr_.

elog | [0 Debug | §

Message

Semi-auto complete

You can manually invoke code completion with the key sequence Ctrl+Space.

Code completion cache

Although code completion is very useful, it takes time to build a list of
possible completions to your code. You may be able to speed things up by
creating a cache. The cache is loaded when the IDE starts up (so it takes a
longer time to start the IDE) so the IDE parses the single cache file instead of the
multiple include files. To add include files to the code completion cache, click on
the Add button and select the file to include in the cache.
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Configure Shortcuts

You can change the keyboard shortcuts by going to the Tools menu and selecting
Configure Shortcuts.

g Configure Shortcuts . E@li_hj

Click on an item and press the shortcut you desire!

Tip: press "Escape” to clear a shortcut...

Menu entry Shortcut assign.. | =

File | Source File Ctrl+M
File | Project...

File | Resource File

File | Template...

File | Open Project or File... Ctrl+0

File | Clear History

File | Save Ctrl+5

File | Save As... Ctrl+F12

| File | Save Project as...

File | Save All

File | Close Ctrl+F4

File | Close All

File | Close Project

File | Properties

File | Import M5 Visual C++ project

File | to HTML

File | to RTF

File | Project to HTML

File | Print Ctrl+P

File | Print Setup -

Use the mouse to select the menu entry for which you wish to add or change a
shortcut. Then, type the new keyboard shortcut for that menu entry. To delete a
shortcut, hit "Esc". Press the "Ok" button when finished.
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Editor Shortcuts

Actions:

These commands perform various actions.

Command "Description |
Control + Shift + B "Go to matching bracket |
Move to marker ‘

Control + (number)

(number)

Control + Shift +

(number) Set marker (number)

Context sensitive help

Fl on word
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Editor Shortcuts

Cursor:

These commands control how the cursor behaves.

Command Description |
Left Arrow Left one character |
Right Arrow Right one character |
Up Arrow Up one line

Down Arrow

Down one line

Control + Left

Left one word

Control + Right Right one word
Home Start of line
End End of line
Page Up Up one page
Page Down Down one page
Left one page
Right one page
Control + Page Up Top of page

Control + Page Down

Bottom of page

Control + Home

Abs begin

Control + End

Abs end
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Editor Shortcuts

Modes:

These commands control modes.

Command "Description

|
Insert "Set insert mode |
"Set overwrite mode |

Toggle insert/overwrite

Control + Shift + N
Control + Shift + C "Selection type is column |
Control + Shift + L "Selection type is line |

Selection type is normal
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Editor Shortcuts

Delete:

All the commands having to do with deleting.

Command "Description
Backspace "Character to left
Shift + Character to left
Backspace

Delete ICharacter to right

Control + T Word to right

Control +

Backspace 'Word to left

"From cursor to start of line

+ Shi i
Control + Shift From cursor to end of line

+Y
Control +Y "Current line
"Everything in editor
Line break at current position, move
Enter
caret
Shift + Enter Line break at current position, move
caret
Control + M Line break at current position, move
caret
Control + N Line break at current position, don't
move caret

Insert character at curent position

Alt + Backspace [[Perform undo if available

Control + Z Perform undo if available

Alt + Shift +

Perform redo if available



Back ||

Control + Shift Perform redo if available

+7Z
Shift + Delete "Remove selection place on clipboard
Control + X "Remove selection place on clipboard

Move clipboard contents to current

Shift + Insert ..
position

Control + V

position

+ Shi ; i
Control + Shift Move selection to right

+1

Control + Shift Move selection to left
+ U

Tab ||Tab key

i
|
i
Move clipboard contents to current ‘
|
|

Shift + Tab "Tab to left
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Editor Shortcuts

Scrolling:

These commands control everything to do with scrolling.

Command "Description |
Scroll Up + Control "Go up one line |
Scroll Down + Control |Go down one line |
Scroll Left

Scroll Right

Left one character

Right one character
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Editor Shortcuts

Selection:

These commands control how the currently highlighted text behaves.

Command "Description |
Shift + Left "Select left |
Shift + Right "Select right |
Shift + Up |Select up

Shift + Down Select down

Control + Shift + Left

ISelect word left
Control + Shift + Right"Select word right

Shift + Home "Select line start |

Shift + End "Select line end |

Shift + Page Up "Select page up |

Shift + Page Down "Select page down |
"Select page left |
"Select page right |

Control + Shift + Page Select page top

Up

Control + Shift + Page Select page bottom

Down

Control + Shift + Select editor top

Home

Control + Shift + End |Select gotoxy

Control + A "Select All |

Control + Insert "Select All |

Control + C Cppy selection to
clipboard




Control +V

Paste selection to
clipboard

Control + X

Cut selection to
clipboard




< Previous < = Home = > Next >




Editor Shortcuts

Visual Designer:

These commands only apply to the wxWidgets visual designer and only work if
a component (i.e. widget) has been selected.

Command [[Description

Move the component one tick to the

Ctrl + Left loft

Ctrl + Right ll:i/[g%\ie the component one tick to the
Ctrl + Up "Move the component one tick up |
Ctrl + Move the component one tick down
Down

Ctrl + Del "Delete the component |
Ctl + X Cut the component from the designer
Ctrl + C Copy the component

Cil + V fPoarstme a copy of the component to the
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ToDo List

wxDev-C++ provides a way to keep track of your "ToDo" list from within your
program's comments. This makes it easy to keep track of incomplete sections of
your source code.

There are two methods for adding items to a ToDo list:

1. Place the cursor somewhere in the source, then either a right mouse click
and select "Add ToDo Item" or just Shift+Ctrl+T.

2. Just embed C/C++ style comments within your code that are prefaced by
the identifier "TODO:". For example,

/* TODO : Add ToDo instructions to help tutorial. */



| Project Inspector 2 x| ProjectlApp.cpp | ['] ProjectlApph | Projectl App.rc | ProjectlFrmuh | ProjectlFrm.cpp | Project * | * [Co

‘P‘roject e Author tony <
E-4% ProjectlFrm : class /S Created: 8/23/2008 7:01:55 PM
47 ProjectlFrmApp : class Description F
= TODD Add ToDo instructions to help tuterial. #
$ifndef _ PROJECTIFRMApp h
#define  PROJECTIFRMApp h
// DONE: Get m1lk aft the store.
$ifdef  BORLANDC _
#pragma hdrztop =
j Py
4 | 1 | b
[® Compiler | 25 Resources | gflj Compile Log | (@) Debug | p Find Results ‘-E',- To-Da List|
Priority Description Filename User

0o Add ToDo instructions to help tuterial. — C\Users\teny\Documents\junk\Projectl App.h

Fiter:| Current file only -

[T Don't show items marked as done
6d: 2 Modifiec Insert 39 lines in file

When the project is reloaded, the "ToDo List" will be displayed. Clicking on the
check mark to the left of the ToDo will change mark the item as "Done".
Double-clicking on the ToDo item will move the editor to that line in the source.

To specify the priority of the ToDo item, add the identifier "
(usernamet#priority#):" to the "TODO :". For example,

// TODO (tony#7#): Download the wxDev-C++ help file
will set the priority level to "7" and the user to "tony" for this item.

Note that the dropdown box labeled "Filter" allows you to view ToDo's that are



within your current open file or within an combination of files in and out of your
project.
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Form Designer Options

Designer Options:

Some basic settings for the wxWidgets form designer can be set through the
Tools menu and selecting Designer Options.

Form Designer Options L&J

Designer Options | Code Generation Clptior15|

Form Grid Behaviour
@Shuw Form Grid |:iFI|:|atir1g
[ Snap to grid

#-coordinate grid interval: 8

AlF |4k

Y-coordinate grid interval: |8

Guide Hints
[¥] Contral
[¥] Size

[¥] Move
[¥] Insert

Grid Settings

In the first box, the grid settings can be modified:

e Show Form Grid - Toggle grid on/off
¢ Snap to Grid - Components will be aligned to the nearest grid point
e X-, Y-coordinate grid interval - The spacing used between grid ticks

Behaviour Settings



In the second box, the visual designer can be set to "floating". When this box
is checked, the visual designer window(s) will be undocked from the IDE.
Floating makes it easier to manage large windows. For example, in the image
below, the two designer forms (left) are floating independently of the wxDev-

C++ IDE (right).

ﬁ FleatingDesigner l

kdit Search View Project bxecute Debug  lools (Vs Window Help

= EIETRIE

|5 6

P2 Y

2

Eiry.] H@@H" | | |J,§|E ‘DNE‘N Elnsert Tog

|

]

ct | Classes

ct Inspector 7 x| [*] FloatingDesignerFrm.wadorm |[“] Untitledl[}lg.hl [*] Untitle

kL FloatingDesigner

Click here to bring designer to front...

=Bl &%

() WiRadioButtonl

| *& To-Do List |

:

er Declaration Gene
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Form Designer Options

Code Generation Options:

The form designer generates wxWidgets C++ code. Some preferences for the
code generation can be set through the Tools menu and selecting Designer
Options.

Form Designer Options Li_E-J

“Designer Clptiu:uns.i. Code Generation Options E
. Code Generation

I | Generate XRC Code

String Internationalization: E -

Sizer Options
| Use wxDefaultPosition

7] Use wxDefaultSize

¢ Generate XRC Code - When checked, the standard wxWidgets C++ code
is replaced by wxWidgets XRC code. XRC is wxWidgets XML-based
resource system.

e String Internationalization - When the code generator passes strings to
the wxWidgets component properties, it uses this function as a wrapper.
Choices are wxT(), _T(), and _().

¢ Sizer Options - Allows the sizer code to use the predefines
wxDefaultPosition and wxDefaultSize rather than a numerical value.


http://docs.wxwidgets.org/stable/wx_xrcoverview.html#xrcoverview

< Previous < = Home = > Next >




Frequently Asked Questions (FAQ)

wxDev-C++ FAQ

Please note that we have a robust wxforum where someone has probably asked
your question already. We also have several online tutorials that are a great help
to the beginner. Finally, Sof T has written a book called "Programming with
wxDev-C++".

If you have web access, please consult our online FAQ.

e What is wxDev-C++?

wxDev-C++ is an extension of Dev-C++ with a Form Designer for the amazing
cross-platform framework wxWidgets. It contains all the features of Dev-C++
alongside a recent wxWidgets distribution along with a form desinger for rapid
application development (RAD).

e Where can I get help for wxDev-C++?

You can either see the available tutorials or post your question in the wxForum.

e Which language is wxDev-C++ written in?

wxDev-C++ and Dev-C++ were written with Borland Delphi 6.0 Personal
Edition, a free (albeit closed-source) compiler for Windows (yes, the irony). Lots
of open-sourced, third party components like the JVCL and extlib are used.

e Where do I obtain the wxDev-C++ source code?

Have a look at our Subversion repository. You can download the source by
clicking on the "Download GNU tarball" link.



http://wxforum.shadonet.com/viewforum.php?f=28
http://wxdsgn.sourceforge.net/?q=node/6
http://wxdevcpp-book.sourceforge.net/
http://wxdsgn.sourceforge.net/?q=node/2
http://www.wxwidgets.org
http://wxdsgn.sourceforge.net/?q=node/6
http://wxforum.shadonet.com/viewforum.php?f=28
http://wxdsgn.svn.sourceforge.net/wxdsgn/

e Will there be a release for Linux?

You will have to ask this question to the core Dev-C++ developers. Since
wxDev-C++ is based on Dev-C++, a Linux distribution will be a possible only if
we have a Linux version of Dev-C++. Some effort (by Tony) have been put in to
compile wxDev-C++ with Lazarus failed. Nuklear Zelph has managed to get
wxDev-C++ running under Wine on the latest version of Ubuntu linux. You may
wish to contact Nuklear on the wxforum if you want to find out how to do this.

e Why does wxDev-C++ take a long time to compile, and the binaries
produced so large?

Because MingW gcc tries to emit code that will work on many platforms, it
tends to be slow at compiling programs. Using the MS VC compiler may speed
up compilation and produce (slightly) smaller binaries.

Large binaries are produced because of static linkage with libstdc++ (which is
said to be bulky) and the static, monolithic build of wxWidgets that we include
in wxDev-C++. Dynamic linkage to wxWidgets can be done if desired (see the
tutorial on building your own wxWidgets library), and switching to STLport is
advised if you need to reduce the binary size.

Most people assume that large binaries are a sign of waste and inefficiency.
This may be true. However, remember that GUI programs are necessarily large
due to the intensive use of graphics (even if you don't take advantage of all that
the graphics can do). It's unlikely you'll produce a useful GUI for under 100 Kb
or even under 1 Mb (even for a "Hello World!" program). So you can build you
own wxWidgets library as a DLL that just includes wxTextCtrl and wxButton,
BUT it's not going to be a very useful library for your other programs (which
may need more components).


http://wxforum.shadonet.com/viewforum.php?f=28
http://wxforum.shadonet.com/viewtopic.php?t=2772&highlight=slow
http://wxforum.shadonet.com/viewtopic.php?t=736&highlight=huge+executable
http://wxdsgn.sourceforge.net/?q=node/9

Dev-C++ FAQ

NOTE: This part of the FAQ is a holdover from Dev-C++ 4.9.9.2 and may no
longer be up-to-date or relevant.

e Why can't I use conio.h functions like clrsrc()?

Because conio.h is not part of the C standard. It is a Borland extension, and
works only with Borland compilers (and perhaps some other commercial
compilers). Dev-C++ uses GCC, the GNU Compiler Collection, as its compiler.
GCC is originally a UNIX compiler, and aims for portability and standards-
compliance.

If you really canot live without them, you can use Borland functions this way:
Include conio.h to your source, and add the following file to your project :
C:\Dev-C++\include\conio.c (where C:\Dev-C++ is where you installed Dev-
C++).

Please note that conio support is not complete.
e My console window keeps closing, how do I change that ?

You can do it this way:

#include <iostream>
int main(int argc, char *argv[])

{
printf ("Press ENTER to
continue...\n");
getchar (); /* wait for input */
return EXIT_SUCCESS;

}

e After linking, i get an error like C:\DEV-C++\LIB\\libmingw32.a(main.o)
(.text+0x8e): undefined reference to "WinMain@16'



You probably haven't declared any main() or WinMain() function in your
program.

e How can i provide a .def file for my DLL ?

Go to the Project menu and select Project Options, Parameters sheet, Linker
box . Add to the textbox, --def yourfile.def

e [ am having strange problems under Windows XP

Try to run Windows Update and make sure that you have the Program
Compatibility updates.

e How do I enable Debugging mode ?

Go to the Project menu and select Project Options and click on the Compiler
sheet. In the Linker section, put “Yes” to 'Generate debugging information'. Do
a 'Rebuild All' and you should be able to debug now.

e When I launch Dev-C++ I get the message saying "WININET.DLL' or
'MSCVRT.DLL' or ‘SHFOLDER.DLL’ not found

You are missing a Windows DLL (and probably have a broken version of
Windows). Please go to the Microsoft Update site and see if you can fix your
installation of Windows.

e How to use assembly with Dev-C++ ?

The "GNU as" assembler uses AT&T syntax (not Intel).
Here's an example of such a syntax :

// 2 global variables
int AdrIO;
static char VvallIo;

void MyFunction(.......... )



{
__asm("mov _AdrIO, %dx") ; //
loading 16 bits register
__asm("mov _VvalIO, %al") ; //
loading 8 bits register

/*

Don't forget the underscore _
before each global variable names '!

*/

__asm("mov %ax,%dx") ; // AX --> DX

e [ am using Windows 98 and I cannot compile

Some users have report that you need to apply several patches to your system.
Here is the list of them, they can be found on Microsoft Windows 98 download

site.

* 47569us.exe - labeled as Windows98SE shutdown

* dcom98.exe - see also this page

* DX81eng.exe - latest version of DirectX (this is 11MB, and cannot be
uninstalled without reinstalling Windows 98. You might want to try this one last
in case the other above didn't work, as it should update many parts of the
system).
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Mailing List / Forum

wxDev-C++

If you have wxDev-C++ specific questions, please post them on the wxforum.
This is the preferred mailing list. Please remember to search the forum for the
answer to your question before posting it. Chances are that someone has already
asked (and answered) it. We also have a Frequently Asked Questions page.

If you're sure that you've found a bug, please post it to our Bug Tracker on
SourceForge.


http://wxforum.shadonet.com/viewforum.php?f=28
http://sourceforge.net/tracker/?group_id=95606&atid=611982

Dev-C++

If you have programming or Dev-C++ specific questions, you can post it on the
forum or on the mailing list.

Bloodshed Software / Dev-C++ Forum : http://bloodshed.net/forum

Dev-C++ Mailing List : http://bloodshed.net/devcpp-ml.html



http://www.bloodshed.net/devcpp.html
http://bloodshed.net/forum
http://bloodshed.net/devcpp-ml.html
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